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Conditions of Use
The Cambridge Structural Database Portfolio (CSD Portfolio)
including, but not limited to, the following: ConQuest, CSD-Editor,
Decifer, Mercury, Mogul, IsoStar, DASH, CSD Conformer Generator,
Hermes, GOLD, SuperStar, the CSD Python API, web accessible CSD
tools and services, WebCSD, CSD sketchers, CSD data files, CSD
data updates, the CSD database, sub-files derived from the
foregoing data files, documentation and command procedures,
test versions of any existing or new program, code, tool, data files,
sub-files, documentation or command procedures which may be

available from time to time (each individually a Component)
encompasses database and copyright works belonging to the
Cambridge Crystallographic Data Centre (CCDC) and its licensors
and all rights are protected.
Any use of a Component of the CSD Portfolio, is permitted solely in
accordance with a valid Licence of Access Agreement or Products
Licence and Support Agreement and all Components included are
proprietary. When a Component is supplied independently of the
CSD Portfolio its use is subject to the conditions of the separate
licence. All persons accessing the CSD Portfolio or its Components
should make themselves aware of the conditions contained in the
Licence of Access Agreement or Products Licence and Support
Agreement or the relevant licence.
In particular:
• The CSD Portfolio and its Components are licensed subject to a
time limit for use by a specified organisation at a specified
location.
• The CSD Portfolio and its Components are to be treated as
confidential and may NOT be disclosed or re-distributed in any
form, in whole or in part, to any third party.
• Software or data derived from or developed using the CSD
Portfolio may not be distributed without prior written approval
of the CCDC. Such prior approval is also needed for joint projects
between academic and for-profit organisations involving use of
the CSD Portfolio.
• The CSD Portfolio and its Components may be used for scientific
research, including the design of novel compounds. Results may
be published in the scientific literature, but each such
publication must include an appropriate citation as indicated in
the Schedule to the Licence of Access Agreement or Products
Licence and Support Agreement and on the CCDC website.

• No representations, warranties, or liabilities are expressed or
implied in the supply of the CSD Portfolio or its Components by
CCDC, its servants or agents, except where such exclusion or
limitation is prohibited, void or unenforceable under governing
law.
Licences may be obtained from:
Cambridge Crystallographic Data Centre
12 Union Road
Cambridge CB2 1EZ, United Kingdom
Web: http://www.ccdc.cam.ac.uk
Telephone: +44-1223-336408
Email: admin@ccdc.cam.ac.uk

Introduction
CSD Editor enables users to manually modify entries from their own
deposited structures on My Structures to maintain consistent and
up-to-date information.

Installation notes
Currently, CSD Editor is available for:
• Windows - Intel compatible, 64-bit:
• Windows 10
• Linux - Intel compatible, 64-bit:
• RedHat Enterprise 7.6 or higher, and 8
• CentOS 7.6 or higher, and 8

The use of ChemDraw integration within CSD Editor requires a
ChemDraw installation – this has been tested using ChemDraw
Professional 17.0. ChemDraw is a product of PerkinElmer
Informatics, Inc. Copyright 1998-2018 All Rights Reserved, http://
www.cambridgesoft.com
We recommend that you do not install directly on top of a previous
installation of CSD Editor.
We recommend that you install the latest version of the CSD
database files including all CSD update files.

Installation procedure
To install CSD Editor on Windows:
1. Download the csd-editor-mystructures-windows-installer.exe
Windows installer.
2. Run the csd-editor-mystructures-windows-installer.exe file and
follow the on-screen instructions to install it.
To install CSD Editor on Linux:
1. Download csd-editor-mystructures-windows-installer.run and
change directory to the location of the download on your
system.
2. Ensure the downloaded file is executable via the command
chmod a+x csd-editor-industrial-mystructures-installer.run

1. Run the installer with the command
./csd-editor-mystructures-windows-installer.run

and follow the on-screen instructions to complete the installation.

Managing structures on My
Structures
My Structures can be used to manage your CIF files and other
supplementary files and to create a database to search in CSDS
software.

Adding structures to your My Structures
table
Adding new structures
Structures can be added by signing in and depositing them
through the deposition service - https://www.ccdc.cam.ac.uk/
deposit/upload.
A workshop tutorial giving instructions on all the steps of the
process is available on the CCDC website: https://
www.ccdc.cam.ac.uk/Community/educationalresources/workshopmaterials/csd-community-workshops/CSDC-Deposition.pdf.

Claiming structures already in the system
Existing structures in the system that you have authored or
deposited can be added to your My Structures view if you know the
Deposition Numbers for the structures or the DOI for the
publication that the structures are published in. To do this:
1. Sign in and go to My Structures.
2. Click the Associate More Structures button and a Associate
Structures dialogue will appear.

3. Add the Publication DOI for the structures that you would like to
add or a list of Deposition Numbers and click Submit. You can
also add a list of Deposition Numbers from a text file.
This system allows you to see data you have deposited or authored
or that have been shared with you by a depositor or author.
Ownership of the data will be checked before the structures are
added. If the data does not get associated with you after two days,
then please contact the original depositor to request that they
update the publication details or share the structure with you.

Viewing details about your structures in
the My Structures table
Changing the columns in the table
1. Click the Three dots next to one of the column headings
2. Hover over the arrow next to the Columns option and the list of
possible columns are displayed.
3. Tick the columns that you would like to view

Viewing more details about a structure
Click the Details button to display more details about an individual
structure.

Editing structures in your My Structures
table
Editing 2D/3D
2D/3D editing of structures is done using the CSD Editor desktop
program. This will need to be installed on your computer before you
start.
1. Select the entries that you want to edit in the My Structures
table, click the Download to Edit 2D/3D button and then click
OK on the dialogue that appears.
2. Click the My Downloads button

3. This will open a Database and Download Requests window
and the file with the structures that require editing should be at
the top of the table. You should refresh the page until the status
for the request goes to Available to Download and the
Download button appears.

4. Click the Download button and save the file on your computer.
5. Open the CSD Editor (C:\Program Files\CCDC\CSD-EditorMyStructures\csd_editor.exe)
6. Click the Open a new or existing session button in the CSD
Editor

7. A Open CSD Editor Session dialogue will open. Check that the
CSDSQLX Database File option is selected and then locate the
file that you saved in step 4 and click Open.

8. The structures will open in the CSD Editor and can be edited.
See the 2D/3D Editing in the CSD Editor section for details of
how to edit the 2D and 3D in theCSD Editor.
9. Once all the structures have been edited you should save the
edits to the database. This can be done by clicking the Save all
structures in session to source database button. A dialogue
will be displayed while the entries are saved and then click Ok.

10. The entries will be saved into the same database that you
opened in step 7. The next stage is to go back to the My
Structures view and click the Upload New 2D/3D button.

11. A Upload New 2D/3D dialogue will appear. Click Select Files,
locate the same file that you opened in step 7, click Open and
then click Confirm.
12. The files will then be saved into the system. This can take a few
minutes and progress can be monitored by clicking the My
Downloads button.

13. When the files have been saved into the system the status will
change to complete and there will be tick with a number for the
total number of entries that have been saved successfully back
into the system.

Adding publication details
1. You can add publication details for your structures from the My
Structure Details page. To access the My Structure Details
page for the structure click on the Details button next to the
structure that you want to add publication details to.

2. From the My Structure Details page you can add a new
publication by clicking the Add Publication button or you can
edit an existing publication by clicking the Edit button.

3. This will bring up a Edit Publication dialogue where you can
add publication details. If you deposited more than one
structure during the deposition then a list of Deposition
Numbers may be listed at the bottom of the dialogue. You can
tick and un-tick the boxes alongside the Deposition Numbers to
indicate to which structures you want to update the publication
for.

4. Once you have added all the publication details you should click
the Save button and you should be returned to the My
Structure Details page.

Adding a compound name
1. You can add a compound name for your structures from the My
Structure Details page. To access the My Structure Details
page for the structure, click on the Details button next to the
structure that you want to add the compound name to.

2. To add the compound name you should click the Click to add
some data text box next to the User Compound Name field,
type in the compound name and click the tick box to confirm.

Adding an identifier
1. You can add an identifier for your structures from the My
Structure Details page. To access the My Structure Details
page for the structure, click on the Details button next to the
structure that you want to add the identifier to.

2. To add the identifier you should click the Click to add some
data text box next to the User Identifier field, type in the
identifier and click the tick box to confirm.

Exporting a database of structures from
My Structures to view and search in CSD
software
Exporting a database of all structures from the My
Structures table
1. Login and go to the My Structures table.
2. Click the Export button with no structures selected and select
the Export filtered as a Database option.

3. A dialogue will appear to say that the download request has
been received. Click Close to close the dialogue

4. Go back to the My Structures table and click My Downloads
button

5. The Database and Download Requests page will open and the
new database export will be displayed at the top of the table.
When the database is ready to be downloaded the Status will be
Available to Download and a Download button will appear.
Click the Download button to download the database (.csdsql
file format).

Using in-house databases with CSD
Portfolio software
Activating your in-house database for use with
ConQuest
ConQuest can search in-house databases separately or in addition
to the main CSD database. After you create or update an in-house
database that you wish to search using ConQuest it must first be
activated using the procedure described below.
In order to activate your in-house database you must copy (or softlink: Linux only) the in-house database file (*.csdsql) to the same
directory as the CSD V5.42 database files.
On Linux this is typically: <INSTALLDIR>/CSD_2022/CSD_543
While on Windows, this is normally: C:\Program
Files\CCDC\CSD_2022\CSD_543

You must then run the Activate program:
• For Linux, ensure that <INSTALLDIR>/CSD_2022/bin is in your PATH
and type:
activate

• For Windows, select Programs -> CCDC -> Activate in-house
database from the Windows Start menu.
Note: Windows 10 users will require escalated administrator
privileges to activate databases. To do so, right-click on the Activate
Inhouse Databases menu item and select Run as Administrator.
In both cases a pop-up window like the one shown below will be
displayed:

• The activation program attempts to find the directory where the
database is located by examining your ConQuest defaults file.
However, if the correct directory cannot be found then use the
Change button to locate the required directory.
• All databases in the selected directory which have not been
activated will be displayed in the Database to activate pulldown menu. Simply select the databases you wish to activate.
• The contents of the Database Name dialogue box will be used
by ConQuest to identify which databases you wish to search or
view. Choose a name relevant to the database contents.
• Enter a version number for the database in the Database
Version dialogue box. If you have an earlier version of a
database, with the same Database Name in the same directory,
it is important to make sure that the most recent version has
the largest version number so that it is used in preference to the
others.
• Enter the date for the database in the Database Date dialogue
box.
• Use Search/Display Order pull-down menu to select the order
in which activated databases will be displayed and searched by
ConQuest. Taking the above example, if you select After CSD
v5.42, when both databases are selected for searching in
ConQuest the main CSD database will be searched before the
in-house database.

• When you are happy with your selections press the Activate
button; this will create an .inf file for the database, which will
then be viewable and searchable the next time you start
ConQuest.
To close the activate database program press the Exit button.
In ConQuest, navigate to View Databases > Available Databases
This opens an Available Databases pane which allows you to add a
directory containing your new database, and also manage which
databases are searched.

Using your in-house database with Mercury
Mercury will use the current CSDS database format (.csdsql) ; from
the Mercury CSD-Core menu, the Select Databases option will
allow selection of the appropriate database file.

2D/3D Editing in the CSD Editor
The CSD Editor has three different tabs. The functionality of these
tabs will be described over the next few pages.

Overview Tab

1. 2D chemical diagram.
2. 3D crystal structure. Generated from the atomic coordinates.
3. Crystallographic, numeric and textual data items. It is not
possible to edit these data items and the boxes are greyed out
to indicate that they are not editable.
4. Top menu bars. The menu items File, Edit, View, Insert, Action,
Calculate and Help are available. These menus contain a
number of different options but all of these options can also be
accessed through toolbars and buttons on the interface. Note
that there are no options available in the Insert menu.
5. Save All button. Saves all the structures back into the database
from which they were downloaded.
6. Save the Current Entry button. Saves just the current structure
that is displayed back into the database from which it was
downloaded.
7. Undo and redo buttons. Allows the last command(s) to be
undone or redone.

8. Undo All button. Allows all the changes since the entry was
loaded (or last saved) to be undone. If you move onto a different
entry then you can no longer undo the changes made to the
previous entry.
9. ChemDraw Chemical Diagram button. Enables the 2D
chemical diagram to be edited using the ChemDraw program (if
this is installed on the computer). The location of the installation
of ChemDraw can be stored by clicking on the Help menu item
and selecting Session Info. The path for ChemDraw can then be
added to the External Diagram Editor field.
10. Generate Chemical Diagram from current crystal structure
button. Generates a 2D chemical diagram from the 3D crystal
structure. Note that the diagram generated each time the
button is used may be different.
11. DOI button. If a DOI is included as part of the Literature
Reference field, clicking this button opens the relevant paper in
a browser if access to the article is available.
12. Generate Formula from Chemical Diagram button. Opens a
dialogue which allows the formula to be calculated. If there are
multiple molecules in the chemical diagram then the
multipliers for each molecule can be defined.
13. Generate a Packing Summary for the Crystal Structure.
Displays the Cell contents, the Formula unit and the Z and Z’
values for the crystal structure.
14. Arrows to move between structures. The left hand button
moves to the first entry in the list, the central button to the
previous entry and the right hand button to the next entry.
15. List of entries. The software determines the relevant menu
depending on the current entry being viewed. In most cases the
display gives a list of all the entries in the current editing session
colour coded by matching status. Green indicates that all of the
chemical moieties in the 2D diagram match perfectly on to the
moieties in the 3D structure. Amber indicates that only some of
the chemical moieties in the 2D diagram match moieties in the
3D structure, likely to be due to disordered or unmodeled

molecules in the 3D structure. A purple colour indicates
moieties present in the 3D structure have not been represented
in the 2D diagram, suggesting the 2D diagram may not
represent all moieties modelled from the X-ray data. Red
indicates that none of the moieties in the 2D diagram match the
moieties in the 3D structure. Black indicates that a match is
impossible because of the absence of a 2D diagram.
16. Current entry identifier. The identifier for the structure
currently displayed.
17. Filter Structure Menu. A drop-down menu which can be used
to filter the list of entries. The filter options allow display of either
all the structures in the current editing session, just the Not
matched (red) entries or just the Partially matched (amber)
entries.
18. Arrows to move between structures. Moves between
structures in the displayed list.
19. Details of Errors, Warnings and Remarks. This section gives a
list of the errors, warnings and remarks related to the structure.
Some of the messages are from the initial analysis of the
structure during conversion, and some are calculated from the
current edits to the structure. A list of the common errors and
warnings are given in the Appendix.
20. Matching Status. Gives details of the matching status of the
entry.

Diagram tab

1. Diagram tab.
2. Right-click menu. The diagram can be copied and pasted
between entries by right-clicking on the diagram and using the
Copy and Paste options. It can also be used to Print the
diagram.

Visualiser tab

A lot of the functionality is identical to the functionality in Mercury.
For a more detailed description of the functionality in the Visualiser
tab see the Mercury documentation.
1. Visualiser tab.
2. Display Style. Select the display style for the 3D structure from
the options in the drop-down menu.
3. Colour Mode. Select the colouring scheme for the atoms and
bonds in the 3D structure. A particularly useful function in some
cases is the ability to colour the 3D structure by matching status
so that it is possible to see which molecules in the structure are
matched to the 2D (green) and which are unmatched (red).
Another useful function is the by Element or Suppression
option which indicates which atoms have been suppressed in
the 3D structure.
4. Picking Mode. Select the picking mode from options in the
dropdown box. This defines what happens when you left-click
on items in the 3D structure; whether it selects the atoms or
measures a distance, angle, etc.

5. Normal and lasso picking modes. Click the icons to change the
picking mode from the normal picking mode to the lasso
picking mode.
6. Show Labels options. Click the Show Labels check box to
show/hide atom labels. Select options from the two drop-down
menus to select the type of atom that is labelled and the type of
label that is shown. A useful function is the Show Labels for
Siteless Neighbours option which will display the labels for only
atoms which have siteless atoms (e.g. atoms with hydrogens
that have no coordinates).
7. Display Options. Click the relevant check box to display certain
options in the 3D structure.
8. More Information button. Opens the More Information
dialogue. From this dialogue, it is possible to suppress,
unsuppress, set the hydrogen count for or delete atom(s) using
a mouse click for a single row, Shift+click for a block and
Ctrl+click for separated rows. This dialogue is customisable and
can show different attributes about the atoms, including label,
occupancy and ADP.
9. Force Match button. Used in situations where edits have been
made to either the 2D diagram or the 3D structure and there is
no longer a perfect or partial match between the two. In such a
situation, if the chemistry represented in the 2D diagram is close
enough to correctly matching the 3D structure, then the bond
types/hydrogen atom assignments etc. in the 3D will
automatically be edited to achieve as complete a match as
possible.
10. Suppress button. Used to suppress atoms in the 3D structures,
to help represent disordered molecules. Select all the atoms
that you want to suppress and then click the Suppress button.
The suppressed atoms will be coloured light green and will not
bond to any other atoms. See the FAQ ‘How should I deal with
disordered structures?’ for more information.
11. Unsuppress button. Used to unsuppress atoms in the 3D
structures. Select all the atoms that you want to unsuppress and
then click the Unsuppress button.

12. Apply Auto Edit button. Useful if the chemistry of the structure
has not been determined correctly (often shown by the
presence of unknown bond types in the 3D structure for a
severely disordered structure). The ‘Apply Auto Edit’ button is a
quick one-click option that uses the default settings suitable for
most situations. To manually configure the Auto Edit options the
‘Auto Edit’ button should be used instead.
13. Auto Edit button. Useful if the chemistry of the structure has
not been determined correctly (often shown by the presence of
unknown bond types in the 3D structure for a severely
disordered structure). The default settings are suitable for most
situations and clicking Apply produces another pop-up window
to show how many (if any) bonds and atoms have been
changed, added or removed and presents a choice to Accept or
Revert the changes.
14. Radii button. Used to edit the default bonding limits for pairs of
elements in the structure and can be a useful way of removing
unwanted bonds from the 3D structure. A tick box is provided to
either include or exclude chemically-unlikely bonds. For most
common cases it is better for this box to be unchecked.
15. Manual Edit button. This opens the dialogue shown in the 3D
structure and allows editing of the 3D structure including
adding atoms and bonds, changing element types and editing
atom and bond properties.
16. Set Bond Type to button. Used to change the bond type of
bonds in the 3D structure.
17. Suppress Atoms and Bonds button. Used to suppress atoms
and bonds in the 3D structure (the Unsuppress atoms button
below will unsuppress atoms). This functionality can be useful if
you have disorder that has not been correctly resolved.
18. Make 2D button. Generates a 2D chemical diagram from the 3D
crystal structure.

19. Projection button. This produces a 2D diagram in the same
orientation as the currently selected view of the 3D structure.
This diagram is generally of lower quality than the diagram
produced by the Make 2D button but it is much faster.
20. Spacegroup button. Allows alternative settings of the space
group to be chosen.
21. Packing button. Allows various options for packing and slicing
the structure.
22. Voids button. Calculates the void volume as a percentage of the
unit cell volume.
23. Structures button. Used when there are two 3D structures in
the display to colour the structures differently and to move
them apart. This will not be useful in most common situations.

Saving entries in the CSD Editor
The entries that you have selected will be saved in a local temporary
database (usually in C:\Users\USERNAME\csd_editor). When you edit
these structures the edits will be saved in this temporary database
every time you move between entries or close the CSD Editor. Since
the edits are saved you can close the CSD Editor and reopen it
which will reopen the edited structures. When you click Save All
the edits will be saved back into the My Structures database from
which you selected the structures initially. When you have saved
the structures back into the database you can upload the edited
structures back to My Structures (see Editing 2D/3D step 11).

CSD Editor FAQs
How should I deal with polymeric structures?
The easiest way to deal with polymeric structures is to reduce the
relevant bond distance pairs to the metal until the structure is not
polymeric. This can be done by going to the Visualiser tab, pressing
the Radii button and reducing the relevant bond distance limits for
all bonds which occur to the metal in the structure. Once all the

polymeric bonds have gone the Make2D button can be used to
generate a new diagram. In some cases it may be necessary to use
the Force Match button to match the structure.

How should I deal with disordered structures?
If a structure contains disorder then the minor occupancy sites
must be suppressed to leave a single representative atomic position
that will then be matched against the chemical diagram.
Suppressed atoms are not deleted; they simply take no further part
in the establishment of the crystallographic connectivity and
therefore will not be used in ConQuest 3D searches. In the majority
of cases, the initial CIF file conversion will have dealt with any
disorder in the structure. If there are atoms in the 3D structure that
have not been dealt with correctly then these atoms can be
suppressed and unsuppressed manually using either the Manual
Edit dialogue or the More Info dialogue in the Visualiser pane. It is
advisable to check that in the top menu, colour is set to by Element
or Suppression.

How do I select all atoms in a molecule in the 3D
structure?
This can be done by holding the Shift key and clicking an atom in
the molecule that you want to select.

How do I select a group of atoms in the 3D structure?
This can be done by holding the Shift+Alt keys and using the
mouse to lasso atoms.

What does the colour coding in the identifier list
signify?
Green indicates that all of the chemical moieties in the 2D diagram
match perfectly on to the moieties in the 3D structure. Amber
indicates that only some of the chemical moieties in the 2D
diagram match moieties in the 3D structure, likely to be due to
disordered or unmodeled molecules in the 3D structure. A purple
colour indicates moieties present in the 3D structure have not been

represented in the 2D diagram, suggesting the 2D diagram may
not represent all moieties modelled from the X-ray data. Red
indicates that none of the moieties in the 2D diagram match the
moieties in the 3D structure. Black indicates that a match is
impossible because of the absence of a 2D diagram.

How can I tell where the CSD Editor is saving edits to
my database?
Any additional structures or updates of existing database entries
are only added to your existing file once the CSD Editor session has
been saved, when the changes are applied to the original source
database. CSD Editor can be closed and reopened without
uploading database entries; in this case edits made within CSD
Editor will be saved but not applied to your source database.
The location of the source database can be found from the Help
menu under the Session Info option. This will record your database
location as the Data Source, with the Session File and Database
File locations referring to the files updated during the CSD Editor
session.

Why do I see an ‘Operation Failed’ message when
trying to open my database in CSD Editor?
When making changes to database entries in CSD Editor the
structures are saved as a separate CSD Editor session file. If you
attempt to re-open a database as part of a pre-existing session it
may cause an error message to occur (see below).

To resolve the error: First close the CSD Editor session, and then
locate the folder containing the CSD Editor session files (typically C:
\Users\USERNAME\csd_editor) and delete the files present. Once these
files are removed CSD Editor can be reopened and used as normal.

What should I do if I get an ‘internal error’ warning?
When deleting and adding entries to a database you may very
occasionally get an ‘internal error’ warning message. If you get this
message then it is recommended that you close and reopen the
CSD Editor.

How do I add a pi-bond to a chemical diagram using
ChemDraw?
Open ChemDraw and draw the atoms for the structure.
Select the Multiple bonds option and change all the pi-bonded
bonds to the single and dotted bond (tautomeric bond).

Select all the atoms that are to be pi-bonded to the metal and
select Structure > Add Multi-Center Attachment. A multi-center
attachment point will appear in the diagram.
Then select the dotted bond option and draw a bond between the
metal atom and the multi-center attachment point.

Close ChemDraw and the diagram in the CSD Editor will have the
pi-bonds displayed.

What is the ‘-journal’ file that is sometimes created
alongside my database files?
This is a temporary file that appears alongside the database file and
is used as part of the normal database transaction rollback
mechanism. This file should not be deleted while the database is in
use.

CSD Editor errors and warnings
Below is a list of the common errors and warnings that are found in
the CSD Editor along with an explanation of each. Note that A, B, C
and D will be replaced by the relevant atom(s) or calculated value in
the messages given in the CSD Editor.
No formula given - no comparison with connectivity
The formula may be missing and can be calculated by
generating a diagram.
Given formula does not agree with chemical connectivity Abstracted: A; Calculated: B
The formula does not agree with the 2D diagram and can be
recalculated by using the Generate Formula from Chemical
Diagram button
formula has unbalanced charges
The formula does not charge balance. The charges can be
edited and the formula recalculated using the Generate
Formula from Chemical Diagram button.
2D: A x B valency C atoms D'

The 2D diagram contains atoms which have unusual valencies.
There may be H atoms missing from C atoms and these can be
added to the atoms from the Visualiser tab.
Diagram atom A has both aromatic and delocalised bonds
An atom in the 2D diagram has unusual aromatic and
delocalised bonds. This can be fixed by manually editing the
diagram from the visualizer tab and then regenerating the
diagram using the Make2D button.
B aromatic atoms(s) that are in rings with poor geometry
In the 2D diagram an aromatic ring has unusual geometry.
This can be fixed by regenerating the diagram using the
Make2D button in the visualizer tab.
No compound name
The compound name field is empty. Please ignore this.
Compound name: mismatched parentheses A
The compound name does not contain the same number of
opening and closing brackets. Please ignore this.
Compound name: letter followed by number
The compound name contains a letter followed immediately
by a number. Please ignore this.
Atom A has unusual valency B
In the 3D structure an atom has an unusual valency. This may
be ok but can be changed if required by editing the 3D
structure in the Visualiser tab.
Crystal connectivity not polymeric but formula polymeric
The formula is polymeric but the 3D structure is not. It is
possible that the formula should not be polymeric and can be
edited by removing the *n* multipliers using the Generate
Formula from Chemical Diagram button.
Crystal connectivity polymeric but formula not polymeric
The formula is not polymeric but the 3D structure is. It is
possible that the formula should be polymeric and can be
edited by adding *n* to the multipliers using the Generate
Formula from Chemical Diagram button.
Crystal connectivity bond: A B C short
A bond in the 3D structure is short. This may be due to
unresolved disorder.
Crystal connectivity: long bonds may have been added manually
This is a warning that the 3D structure contains bonds which
are longer than the default limits in the CSD Editor. These may

have been added manually and so there is no change
required.
Crystal structure: A % voids
This is a warning that the structure contains void space. This
may sometimes be due to missing or unmodelled solvent
molecules.
Dcalc is too small, no density check
Please ignore this.
Dalc differs from Dx by >2%, try adjusting Z value
Please ignore this.
No R factor for entry category=3
Please ignore this.
Formula: estimated vol A calc vol B differs by C %; check Z
The cell volume is estimated from the molecular formula using
average effective atomic volumes derived by D. Hoffman, but
based on the '17Å per non-H atom' idea and is compared with
the volume calculated from the cell parameters. If there is a
difference then the structure may have an incorrect Z value or
may contain void space.
Calc fw A differs from publ fw B by C (D %)
The calculated formula weight differs from the formula weight
given in the CIF. This may be due to an incorrect formula
which can be recalculated using the Generate Formula from
Chemical Diagram button.
Element A in formula but not in compound name
The calculated formula contains an element that is not given
in the compound name. Please ignore this.
Element A in compound name but not in formula
The compound name contains an element that is not given in
the calculated formula. Please ignore this.
Compound name: poly or catena needed for polymeric formula
The formula is polymeric but the compound name does not
contain ‘catena’ or ‘poly’. Please ignore this.
Chem & Crystal connectivities not matched
None of the chemical moieties in the 2D diagram match with
any of the moieties in the 3D structure. This may be fixed by
editing the 3D structure or the 2D diagram. Using the Force
Match button is a way of adding the chemistry in the 2D
diagram to the 3D structure.
Crystal fully matches Chem connectivities, but not vice-versa

Some of the chemical moieties in the 2D diagram do not
match with some of the moieties in the 3D structure. This may
be fixed by editing the 3D structure or the 2D diagram. Using
the Force Match button is a way of adding the chemistry in
the 2D diagram to the 3D structure.
Chem fully matches Crystal connectivities, but not vice-versa
Some of the chemical moieties present in the 3D structure are
not represented in the 2D diagram. Using the Edit > Create
Chemical Diagram option will represent all 3D moieties in the
2D diagram; tools such as the Auto Edit function from the
Visualiser pane may be required to consistently represent the
chemistry shown in the 3D structure.
Chem & Crystal matching impossible
It is not possible to match the moieties in the 3D structure
with the moieties in the 2D structure. This is probably due to a
missing 2D diagram.
Published bond: A B given but not found in calc
A bond given in the CIF does not correspond to a bond given
in the calculated 3D structure. This may indicate that there is a
bond missing in the 3D structure or that the published bond
list contains an incorrect bond. The published bond list can be
edited by clicking on More Info in the Visualiser tab and then
clicking on Published Bond.
Published bond: A B short
A bond given in the CIF is shorter than the default limits in the
CSD Editor. This may indicate that there is a problem with the
position of an atom in the 3D structure or that the published
bond list is incorrect. The published bond list can be edited by
clicking on More Info in the Visualiser tab and then clicking
on Published Bond.
Published bond: A B long
A bond given in the CIF is longer than the default limits in the
CSD Editor. This may indicate that there is a problem with the
position of an atom in the 3D structure or that the published
bond list is incorrect. The published bond list can be edited by
clicking on More Info in the Visualiser tab and then clicking
on Published Bond.
Spacegroup does not agree with symmetry operators
This is a message that is added when an entry is created and
indicates that the space group given in the CIF does not agree

with the list of symmetry operators given in the CIF. The list of
symmetry operators can be viewed by clicking on More Info in
the visualiser tab and then clicking on Symmetry.
No Z value
The Z value is missing from the entry. Please ignore this.

